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Welcome

Welcome to HyperDeck!

Welcome to HyperDeck!

We hope you share our dream for the television industry to become a truly creative industry by allowing 
anyone to have access to the highest quality video.

Our range of HyperDeck disk recorders have made it easier and more affordable than ever to record 
and play back full 10-bit uncompressed video. HyperDeck records directly to removable 2.5” Solid State 
Disks (SSDs) that are getting bigger, faster and more affordable every day. It’s incredible that you can now 
record the most amazing quality SD and HD video onto something so small, and record and play an SSD 
thousands of times without any degradation in quality!

You can bypass unwanted camera compression and record directly from HDMI or SDI cameras straight to 
SSD and even connect to any HDMI or SDI monitor for instant playback! With HyperDeck Studio Pro, you 
can connect analog sources and also play back 4K through HDMI or SDI in real time! SSDs can also be 
mounted on any computer for immediate editing and fast transfer of your media. With no moving parts, 
SSDs are unbelievably robust and can handle harsh conditions that would destroy conventional hard drives 
and videotapes!

If you need longer recording times for each SSD, then HyperDeck also records and plays back Apple 
ProRes and Avid DNxHD files. These 10-bit quality codecs retain fantastic picture quality and increase the 
recording length of SSDs by more than 5 times!

This instruction manual contains all the information you need to start using your HyperDeck disk recorder. 
For uncompressed recording you need to use an SSD that supports the required data speed and we are 
continually adding details on our website of new SSDs that we have tested. 

Please check the support page on our web site at www.blackmagicdesign.com for the latest version of 
this manual and updates to the HyperDeck software. Keeping your software up to date will always ensure 
you get all the latest features. When downloading software, please register with your information so we 
can keep you updated when new software is released. We are constantly working on new features and 
improvements, so we would love to hear from you!

Grant Petty
CEO Blackmagic Design

http://www.blackmagicdesign.com
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Introducing HyperDeck
HyperDeck disk recorders record uncompressed SD and HD video quality directly to low cost solid state 
disks. Video playback can be viewed on an SDI or HDMI monitor or you can connect the SSD to a computer 
and edit directly from the SSD media itself. HyperDeck disk recorders have internal 3 Gb/s SATA ports which 
are used with standard 2.5" SSDs.

HyperDeck disk recorders have SDI and HDMI connectors making it easy to work with a huge range of 
professional and consumer video equipment. SDI and HDMI connectors also support embedded audio.

HyperDeck Shuttle is compact, affordable and battery powered, so it’s perfect as a field recorder. HyperDeck 
Shuttle bypasses your camera’s compression and records from SDI and HDMI directly into the highest 
quality uncompressed video. The latest model can even record and play back in the Apple ProRes and Avid 
DNxHD formats if compressed video better suits your workflow or if you need to fit more video on an SSD.

HyperDeck Shuttle Mounting Plate can be purchased if you want to secure your HyperDeck Shuttle to a 
camera rig with your choice of rail mounts, cold shoe mounts, articulated arms and more. You can also use 
the plate to power your HyperDeck Shuttle from an external battery by attaching a V-Mount or Anton Bauer 
style battery plate.

HyperDeck Studio is a rack mount broadcast deck style recorder that features dual SSD slots so it can 
automatically continue recording onto the next SSD when one disk is full. HyperDeck Studio features 
uncompressed video quality recording and playback, RS-422 deck control, genlock, jog and shuttle, an 
integrated LCD, and is affordable and easy to use. It can even record and play back in the Apple ProRes and 
Avid DNxHD formats if compressed video better suits your workflow or if you need to fit more video on an 
SSD. HyperDeck Studio is the broadcast deck for the 21st century!

HyperDeck Studio is rack-mountable and is only 1 RU high and less than 4 inches deep. It's the perfect size 
when space is tight such as in broadcast vans and fly away rack cases.

HyperDeck Studio Pro does everything that HyperDeck Studio does, with the addition of analog video and 
audio inputs, ThunderboltTM connectivity and 4K ProRes video playback!

HyperDeck Studio

HyperDeck Studio Pro

HyperDeck Shuttle
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About SSDs

Choosing a Fast SSD
When working with uncompressed video it's important to carefully check the SSD you would like to use. 
This is because some SSDs can have up to 50% lower write speed than the manufacturer’s claimed speed, 
so even though the disk specifications claim an SSD is fast enough to handle video, in reality the disk is not 
fast enough for real time video data recording. Hidden data compression mostly affects recording and often 
these disks can still be used for real time playback.

In our testing, we have found larger newer models of SSD, and larger capacity SSDs are generally faster. 
SSDs recommended for use with HyperDeck and uncompressed 10-bit HD video recording include:

 � Crucial 256GB C300
 � Crucial 512GB M4 (firmware 009)
 � Kingston 64GB SSDNow V+100
 � Kingston 128GB SSDNow V+100
 � Kingston 240GB SSDNow V+200
 � Kingston HyperX 240GB
 � OCZ 240GB Vertex 3
 � OCZ 480GB Vertex 3
 � Sandisk Extreme 480GB.

Please check the tech notes on the Blackmagic Design web site for the latest information.

If you find an SSD which isn’t fast enough for uncompressed HD video, try a faster SSD or use HyperDeck 
Utility to switch to a compressed recording format such as ProRes or DNxHD. These recording formats have 
a much lower data rate and are easier for the SSD to handle.
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Preparing SSDs for HyperDeck
SSDs used by HyperDeck must be formatted as either HFS+ or exFAT. These disk formats allow long clips 
to be recorded in a single file per clip. Simply connect the SSD to your computer with an external dock or 
cable adapter and format it as you would a regular disk. Make sure you back up anything important from 
your SSD as you will lose everything on it when you format it.

HFS+ is also known as Mac OS Extended. It is the recommended format for HyperDeck as it supports 
"journaling". In the event of a hardware or software malfunction, data on a journaled SSD is more quickly 
recovered and less likely to be corrupted in the first place. HFS+ is natively supported by Mac OS X. 
Windows computers can use HFS+ with the purchase and installation of MediaFour MacDrive software 
from http://www.mediafour.com.

ExFAT is supported natively by Mac OS X and Windows without needing to purchase any additional 
software. However exFAT does not support journaling which means data is more prone to corruption, and 
less likely to be recovered, in the event of a hardware or software malfunction.

Preparing SSDs on a Mac OS X computer
The Disk Utility application included with Mac OS X can format a drive in the HFS+ or exFAT formats.

Step 1. Connect the SSD to your computer and dismiss any message offering to use your SSD for Time 
Machine backups.

Step 2. Go to /Applications/Utilities and launch Disk Utility.

Step 3. Click on the disk icon of your SSD and then click the Erase tab.

Step 4. Set the Format to "Mac OS Extended (Journaled)" or "exFAT", type a Name for the new volume 
and then click Erase. Your SSD will quickly be formatted and made ready for use with HyperDeck.

Preparing SSDs on a Windows computer
MacDrive software can format a drive in the HFS+ format on a Windows PC.

Step 1. Install MediaFour MacDrive and restart your PC.

Step 2. Connect the SSD to your computer.

Step 3. Choose Start>Computer and right-click on your SSD.

Step 4. From the contextual menu, choose MacDrive>Format Mac Disk.

Step 5. Select the SSD in the MacDrive Disk Manager and choose Initialize disk>Initialize as GPT.

Step 6. Choose "Automatically create an HFS+ volume" and click "Initialize Disk".

Step 7. Once the format has been completed, your SSD is ready for use with HyperDeck.

Use Disk Utility on Mac OS X to erase your SSD in the 
Mac OS Extended (Journaled) or exFAT format.

Use MacDrive software on Windows to initialize the SSD with a 
GPT and create an HFS+ volume.

http://www.mediafour.com
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The Format dialog box can format a drive in the exFAT format on a Windows PC.

Step 1. Connect the SSD to your computer.

Step 2. Choose Start>Computer and right-click on your SSD.

Step 3. From the contextual menu, choose Format.

Step 4. Set the file system to "exFAT" and the allocation unit size to 128 kilobytes.

Step 5. Type a volume label, select "Quick Format" and click "Start".

Step 6. Your SSD will quickly be formatted and made ready for use with HyperDeck.

Use the Format dialog box feature in Windows to format your 
SSD in the exFAT format.
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Selecting Your Video Format
All current HyperDeck models let you select from a choice of uncompressed and compressed video formats. 
The original HyperDeck Shuttle exclusively records uncompressed video.

HyperDeck can play back 10 bit uncompressed QuickTime files on a fast SSD, or to a compressed format 
if you have a slower SSD or want to fit longer high definition recordings on a single SSD. This means it is 
possible to have uncompressed QuickTime files as well as compressed files on the same disk if you have 
used the HyperDeck Utility software to change the recording format. 

Working with uncompressed video is exciting as there is no better quality than uncompressed. However if 
compressed video better suits your workflow, or if you need to fit more video on an SSD, you can choose a 
high quality professional compressed video format which is also perfect for editing.

To choose a compressed video format:

Step 1. Connect HyperDeck to your computer via USB.

Step 2. Launch HyperDeck Utility. The HyperDeck model which is connected will be named in the title bar 
of the utility.

Step 3. Set the recording format to the desired codec from the pulldown menu and save the setting.  
You can now disconnect the USB cable if you wish.

All subsequent clips will be recorded in the compressed format. If you want to switch back to uncompressed 
video, repeat the procedure and choose Uncompressed 10 Bit from the pulldown menu.

Setting the recording format also sets the playback format so you will only be able to play back clips that 
match the current recording format. Any other clips will be hidden which helps prevent slow SSDs from 
being accidentally used to play back high data rate uncompressed clips which they might not be fast 
enough to play.
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Recording and Playing Clips
HyperDeck ships ready to record and play back with uncompressed SD and HD video quality. You can start 
recording immediately without having to configure any settings and all you need is a recommended SSD 
formatted in the HFS+ or exFAT format.

The Using HyperDeck section in this manual provides information about changing settings for recording 
and playback as well as more detailed steps for recording, playback and using RS-422 control.

If HyperDeck records from a video source that contains closed caption data, your HyperDeck will record the 
QuickTime or MXF movie as well as a separate .MCC file containing the closed caption data. The .MCC file 
will have the same name as your recorded movie but with a .MCC extension.

Recording Video with HyperDeck Shuttle
Step 1. Insert a recommended SSD which has been formatted in the HFS+ or exFAT format.

Step 2. Connect your video source to the SDI or HDMI input and the Video status LED should light up.

Step 3. Press the Record button and the SSD light will flash to indicate SSD activity.

Step 4. Press the Stop button to finish your recording.

Recording Video with HyperDeck Studio Models
Step 1. Insert a recommended SSD, formatted in the HFS+ or exFAT format, into either SSD slot.

Step 2. Connect your video source to a HyperDeck Studio input. Press the INPUT button once while the 
stop button is illuminated to preview the video source on the LCD before recording. If you don’t 
see the video you want, press the button again to switch between the HDMI and SDI inputs.

Step 3. Press the record button to start recording to the SSD instantly. The SSD slot light will illuminate 
with a looping red light to indicate it is being used for recording.

Step 4. Press the Stop button to finish your recording.

If the record button flashes, this means the disk is not fast enough and recording cannot keep up. We 
recommend you change to a compressed recording format such as ProRes or DNxHD, or use a faster 
recommended SSD for uncompressed recording.

HyperDeck Shuttle recording video.

HyperDeck Studio recording video.
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Playing Video
Playing back a clip is simple and instantaneous.

If you’re recording with HyperDeck Shuttle, press the Stop button once to stop recording. Press it again to 
switch to playback. Then simply press Play and you'll see your video on any displays connected to the SDI 
and HDMI outputs.

If you’re recording with a HyperDeck Studio model, press the play button once for instant playback and 
you'll see your video on any displays connected to the SDI and HDMI outputs.

The controls of HyperDeck work just like a CD player so pressing next clip will skip to the start of the next 
clip and continue playing. Press previous clip once to go to the start of the current clip or press twice to skip 
back to the start of the previous clip.

If the play button flashes, this means the disk is not fast enough and playback cannot keep up. We 
recommend you change to a compressed recording format such as ProRes or DNxHD, or use a faster 
recommended SSD for uncompressed recording.

If you play back a video clip which has an associated .MCC file, the closed caption data will be played out 
with the video via the SDI output of your HyperDeck.

Accessing Media on Mac OS X
Compressed and uncompressed QuickTime™ movies recorded by HyperDeck can be opened in almost any 
video software on Mac OS X.

DNxHD MXF files recorded by HyperDeck can be opened with Avid Media Composer and DaVinci Resolve 
for Mac.

MCC closed caption data files recorded by HyperDeck can be opened with MacCaption software for Mac 
OS X from http://www.cpcweb.com.

Accessing Media on Windows
Compressed and uncompressed QuickTime™ movies recorded by HyperDeck require QuickTime be 
installed on your PC. Almost any video software on Windows that supports QuickTime can open movies 
recorded by HyperDeck. QuickTime for Windows can be downloaded free from Apple’s website at  
http://www.apple.com/quicktime/download/.

DNxHD MXF files recorded by HyperDeck can be opened with Avid Media Composer and DaVinci Resolve 
for Windows.

MCC closed caption data files recorded by HyperDeck can be opened with CaptionMaker software for 
Windows from http://www.cpcweb.com.

HyperDeck Shuttle playing back video.

HyperDeck Studio playing back video.

http://www.apple.com/quicktime/download/
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Externally Controlling Your HyperDeck
There are several ways you can remotely control your HyperDeck and more detailed instructions are 
provided in the "Using HyperDeck" section of this manual.

SDI Start/Stop Recording
Start/stop recording means that when you press the record button on an HD-SDI camera, HyperDeck will 
start recording without also having to press the record button on your HyperDeck disk recorder. You will 
need a camera which can trigger the "record" function of HyperDeck via HD-SDI.

Use HyperDeck Utility to set Trigger recording to "When SDI start/stop is detected". On HyperDeck Studio 
models, the REM button needs to be selected to allow trigger recording.

Timecode Run Recording
Timecode run recording is similar to start/stop recording but is only used if your HD-SDI camera does not 
support trigger recording via HD-SDI.

Change your camera's timecode settings from "free run timecode" to "record run timecode" and use 
HyperDeck Utility to set Trigger recording to "When SDI timecode runs". On HyperDeck Studio models, 
the REM button must also be pressed and illuminated to allow trigger recording.

Now whenever your HyperDeck detects the timecode running via HD-SDI, it will start recording. It will stop 
recording whenever the timecode stops.

Be careful if your HyperDeck is connected to the SDI output of a video router, as any change to the video 
source might cause HyperDeck to start recording unexpectedly due to a change in timecode being 
detected via HD-SDI.

RS-422 Deck Control
You can remotely control HyperDeck Studio models using your favorite NLE software and video capture 
hardware to remotely capture, batch capture and play back video with your HyperDeck Studio. All you need 
to do is connect an RS-422 cable between your capture device and HyperDeck Studio and press the REM 
button to enable remote deck control.
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HyperDeck Utility
Blackmagic HyperDeck Utility is used to change settings and update the internal software in your 
HyperDeck. In addition to installing HyperDeck Utility, uncompressed 10 bit codecs are installed for Mac 
and Windows. If you use Avid Media Composer 6.x, you'll also find a HyperDeck Studio deck preset is 
installed to help with RS-422 deck control.

How to Update Your HyperDeck Software on Mac OS X
After downloading the HyperDeck Utility software and unzipping the downloaded file, open the resulting 
disk image to reveal its contents.

Launch the HyperDeck Installer and follow the onscreen instructions.

After installing the latest Blackmagic HyperDeck Utility on your computer, connect a USB cable between 
the computer and the HyperDeck. Launch Blackmagic HyperDeck Utility and follow any onscreen prompt 
to update the internal software in your HyperDeck. If no prompt appears, the internal software is up to date 
and there is nothing further you need to do. We recommend you also update your HyperDeck to ensure 
you are able to get any new software.

How to Update Your HyperDeck Software on Windows
After downloading the HyperDeck Utility software and unzipping the downloaded file, you should see a 
HyperDeck Utility folder containing this PDF manual and the HyperDeck Utility installer.

Double-click the installer and follow the onscreen prompts to complete the installation.

After installing the latest Blackmagic HyperDeck Utility on your computer, connect a USB cable between 
the computer and the HyperDeck. Launch Blackmagic HyperDeck Utility and follow any onscreen prompt 
to update the internal software in your HyperDeck. If no prompt appears, the internal software is up to date 
and there is nothing further you need to do. We recommend you also update your HyperDeck to ensure 
you get the latest software features.
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Using HyperDeck

Disk Check
When you first switch on HyperDeck, or any time you insert an SSD, the SSD indicator will light up while 
checking the SSD and then switch off. If the SSD has not been formatted correctly, or fails to work, the SSD 
indicator will illuminate solid red until the SSD is removed. Refer to the previous section "Preparing SSDs for 
HyperDeck" to check if the SSD is formatted correctly and also check that it works with a computer.

Recording

Recording Clips with HyperDeck Shuttle
Before recording, format a recommended SSD in the HFS+ or exFAT format and use HyperDeck Utility to 
choose your recording format.

Step 1. Insert the formatted SSD into HyperDeck Shuttle. As it reads the disk, the SSD light on the unit will 
illuminate. When the light goes off, HyperDeck Shuttle is ready to record.

Step 2. Connect your video source to the HyperDeck Shuttle’s input. It doesn’t matter if you use the 
HDMI or SDI input, as HyperDeck Shuttle will automatically detect which one is connected. You 
can also connect the video output of the HyperDeck Shuttle to your HDMI or SDI monitor. All 
outputs are active so you can use either one connection or both SDI and HDMI outputs together.

Step 3. If you see the Video status LED light up, it means that HyperDeck Shuttle has detected a valid 
video input.

Step 4. If you don’t see your source video on the output, press the Stop button to switch HyperDeck 
Shuttle between video input loop through and playback.

Step 5. Press the Record button and HyperDeck Shuttle will start recording instantly. The SSD light will 
also flash to indicate the SSD activity. Once you’ve finished recording, press the Stop button.

 If the Stop button starts flashing while recording, there are only 3 minutes of recording time left 
on the SSD. Make sure you have another empty SSD ready so you don’t miss the next take.
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Recording Clips with HyperDeck Studio Models
Before recording, format a recommended SSD in the HFS+ or exFAT format and use HyperDeck Utility to 
choose your recording format.

Step 1. Insert a recommended and correctly formatted SSD into either SSD slot.

Step 2. Connect your video source to an input on your HyperDeck Studio. Press the INPUT button once, 
while the stop button is illuminated, to preview the video source on the LCD before recording. If 
you don’t see the video you want, press the button again to switch between the HDMI and SDI 
inputs. You can also connect the video outputs of your HyperDeck Studio to your HDMI and SDI 
monitors. All outputs are active so you can use one or more outputs together.

Step 3. Press the record button to start recording to the SSD instantly. The SSD slot light will illuminate 
with a looping red light to indicate it is being used for recording.

Step 4. Press the Stop button when you've finished recording.

Start/Stop Recording
HyperDeck Shuttle and HyperDeck Studio models support start/stop recording which means that, when 
you press the record button on an HD-SDI camera, HyperDeck will start recording without also having to 
press the record button on your HyperDeck disk recorder.

To set up start/stop recording for supported cameras:

Step 1. You will need a camera which can trigger the "record" function of HyperDeck via HD-SDI. 
Cameras which support trigger recording via HD-SDI may include menu options such as "Trigger 
REC", "HD-SDI Remote I/F" or "SDI Remote Start/Stop Trigger".

Step 2. In HyperDeck Utility, set Trigger recording to "When SDI start/stop is detected". The REM button 
must also be pressed and illuminated on HyperDeck Studio to allow trigger recording.



Using HyperDeck as a Disk Recorder16

Timecode Run Recording
HyperDeck Shuttle and HyperDeck Studio models also support timecode run recording, which is similar to 
start/stop recording, but is only used if your HD-SDI camera does not support trigger recording via HD-SDI.

To set up timecode run recording:

Step 1. Go into your camera's timecode settings and change them from "free run timecode" to "record 
run timecode".

Step 2. In HyperDeck Utility, set Trigger recording to "When SDI timecode runs". The REM button must 
also be pressed and illuminated on your HyperDeck Studio to allow trigger recording.

Now whenever your HyperDeck detects the timecode running via HD-SDI, it will start recording. It will stop 
recording whenever the timecode stops.

If your HyperDeck is connected to the SDI output of a video router, any change to the video source might 
cause HyperDeck to start recording unexpectedly due to a change in timecode being detected via HD-SDI.

Recording RP 188 Embedded Timecode
When recording from HD-SDI video sources which provide embedded SMPTE RP 188 metadata, switching 
on the option to "Use SDI video input timecode when recording" will record the embedded timecode from 
the video source instead of using timecode generated by your HyperDeck. It might be necessary to turn on 
the RP 188 setting in your camera before HyperDeck will be able to record the timecode.

The LCD on HyperDeck Studio models displays embedded  
SDI timecode when the option to "Use SDI video input timecode 
when recording" is switched on.
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Playback

Playing Back Clips
Playing back a clip is simple and instantaneous.

If you’re recording with HyperDeck Shuttle, press the Stop button once to stop recording. Press it again to 
switch to playback. Then simply press Play.

If you’re recording with a HyperDeck Studio model, press the play button once for instant playback.

The controls of HyperDeck work just like a CD player so pressing next clip will skip to the start of the next 
clip and continue playing. Press previous clip once to go to the start of the current clip or press twice to skip 
back to the start of the previous clip.

Accessing Your Clips
HyperDeck can play back movies in the QuickTime and MXF file formats including closed caption data.

QuickTime movies require QuickTime be installed on your computer. QuickTime for Mac is built into  
Mac OS X™. QuickTime for Windows™ can be downloaded free from Apple’s website at: 
http://www.apple.com/quicktime/download/.

DNxHD MXF files can be used with Avid Media Composer and DaVinci Resolve on Mac OS X and Windows.

MCC closed caption data files recorded by HyperDeck can be opened with MacCaption software for Mac 
OS X and CaptionMaker software for Windows. This software is available from http://www.cpcweb.com.

http://www.apple.com/quicktime/download/
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Playing Back RP 188 Embedded Timecode
If you use HyperDeck Utility to switch on the option to "Play back media timecode track to SDI output" 
when playing back high definition video, your HyperDeck will embed SMPTE RP 188 metadata allowing 
other video equipment to display or record the timecode.

Timecode is also commonly displayed on HD-SDI monitors but you will often need to find a menu setting 
to turn it on. The LCD on HyperDeck Studio models also displays the RP 188 timecode during playback.

Looping Playback
HyperDeck Shuttle - Press the play button when a clip is playing to initiate loop mode. Loop mode will 
continue until you press stop. 

HyperDeck Studio models - Enable loop mode during playback by pressing the play button. The display 
will show if loop mode is on or off. 

Shuttling with HyperDeck Shuttle
If you’re reviewing a long clip and need to quickly shuttle to a particular section, just hold down the Previous 
Clip or Next Clip button. This will allow you to reverse or fast forward through the clip at 2x speed. To go 
faster, press the Previous Clip or Next Clip button again and the speed will increase to 4x and then 8x. Once 
you’ve found the section you want to review, press Play and playback will resume at normal speed.

Jog and Shuttle with HyperDeck Studio Models
If you’re reviewing a long clip and need to quickly shuttle to a particular section, press the reverse or fast 
forward button to play through the clip at 2x speed. To go faster, press the reverse or fast forward button 
again and the speed will increase to 4x and then 8x. Once you’ve found the section you want to review, press 
play to resume normal playback.

You can also use the Jog/Shuttle Wheel to shuttle to a particular section at variable speeds. The more you 
turn it forwards or backwards, the faster your HyperDeck Studio will play through your video. Once you’ve 
found the section you want to review, press play to resume normal playback.

If you want to slowly jog through your video, frame by frame, press the JOG button once to enable jog 
operation. Turning the jog/shuttle wheel in the desired direction will then jog through your video. Pressing 
the JOG button again will return the wheel to shuttle operation.

The LCD on HyperDeck Studio models displays embedded  
SDI timecode during playback when the option to "Play back 
media timecode track to SDI output" is switched on.
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RS-422 Control

What is RS-422 Control?
The RS-422 standard is commonly supported by NLE hardware and software and allows video players and 
recorders to be remotely controlled by an external RS-422 controller or capture device.

Using an External RS-422 Controller
Both HyperDeck Studio models feature an industry standard, Sony™ compatible, RS-422 deck control port 
which has the correct pin connections for a direct connection to any remote controller with RS-422.

You can use pre-manufactured 9 pin cables as long as each end of the cable is wired “pin for pin” where 
the same pin number on each end of the cable are connected together. If you would like to make custom 
cables, please refer to the accompanying wiring diagram.

You can remotely control your HyperDeck Studio from an RS-422 controller, instead of locally pushing 
buttons.

Step 1. Connect a video signal to an SDI or HDMI video input of your HyperDeck Studio.

Step 2. Connect an RS-422 cable between your external controller and your HyperDeck Studio.

Step 3. Press the REM button to enable remote deck control.

You can now remotely start and stop recording and playback of your HyperDeck Studio as well as performing 
other common jog and shuttle functions. The full list of supported RS-422 commands is in the following 
section named "Supported RS-422 Commands".

Daisy-chaining for Crash Recording
You can simultaneously record the same SDI video signal to multiple HyperDeck Studios. You'll need to 
press the REM button on each HyperDeck Studio to enable remote deck control. Each HyperDeck Studio 
can be set to record in a compressed or uncompressed video format using HyperDeck Utility.

If you're working with high definition video, you only need a single channel RS-422 controller connected 
to the first HyperDeck Studio and then loop the HD-SDI signal to the other HyperDeck Studios using the 
SDI loop output. Use HyperDeck Utility to set "Trigger recording" to "When SDI timecode runs" and all 
HyperDeck Studios will record the same video signal simultaneously.

If you ever work with standard definition video, you will need a multiple channel RS-422 controller connected 
to each HyperDeck Studio via RS-422. Connect a video signal to the SDI video input of one HyperDeck 
Studio and then loop the SD-SDI signal to the other HyperDeck Studios using the SDI loop output.

You can now use your external RS-422 controller to set multiple HyperDeck Studios to remotely crash record 
the same video signal.

Receive  
(–)

Receive  
(+)

Transmit  
(–)

Transmit  
(+)

Ground 
Pins

2 7 8 3 1, 4, 6, 9

5 4 3 2 1

9 8 7 6

RS-422 remote pin connections.
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Command Reply No Remote Notes

0 - System Control

0x00 0x11 DeviceTypeRequest
NTSC: 0xF0E0 
PAL: 0xF1E0 
24P: 0xF2E0

Enabled

1 - Slave Response

0x20 0x00 Stop Acknowledge Disabled

0x20 0x01 Play Acknowledge Disabled

0x20 0x02 Record Acknowledge Disabled

0x20 0x10 FastFwd Acknowledge Disabled

0x21 0x11 JogFwd1 Acknowledge Disabled

0x22 0x11 JogFwd2 Acknowledge Disabled
Treated as N=1; 

Same as JogFwd1

0x21 0x12 VarFwd1 Acknowledge Disabled Uses ShuttleFwd1

0x22 0x12 VarFwd2 Acknowledge Disabled
Treated as N=1;  

Same as VarFwd1

0x21 0x13 ShuttleFwd1 Acknowledge Disabled

0x22 0x13 ShuttleFwd2 Acknowledge Disabled
Treated as N=1; 

Same as ShuttleFwd1

0x20 0x20 Rewind Acknowledge Disabled

0x21 0x21 JogRev1 Acknowledge Disabled

0x22 0x21 JogRev2 Acknowledge Disabled
Treated as N=1; 

Same as JogRev1

0x21 0x22 VarRev1 Acknowledge Disabled Uses ShuttleRev1

0x22 0x22 VarRev2 Acknowledge Disabled
Treated as N=1; 
Same as VarRev1

0x21 0x23 ShuttleRev1 Acknowledge Disabled

0x22 0x23 ShuttleRev2 Acknowledge Disabled
Treated as N=1; 

Same as ShuttleRev1

0x20 0x30 Preroll Acknowledge Disabled

0x24 0x31 CueData Acknowledge Disabled

0x20 0x34 SyncPlay Acknowledge Disabled

Supported RS-422 Commands
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Command Reply No Remote Notes

0x21 0x38 ProgSpeedPlayPlus Acknowledge Disabled

0x21 0x39 ProgSpeedPlayMinus Acknowledge Disabled

0x20 0x40 Preview Acknowledge Disabled Status bits are set

0x20 0x41 Review Acknowledge Disabled Status bits are set

0x20 0x43 OutpointPreview Acknowledge Disabled

0x22 0x5C DMCSetFwd Acknowledge Disabled

0x22 0x5D DMCSetRev Acknowledge Disabled

0x20 0x60 FullEEOff Acknowledge Disabled

0x20 0x61 FullEEOn Acknowledge Disabled

0x20 0x63 SelectEEOn Acknowledge Disabled

4 - Preset/Select Control

0x40 0x10 InEntry Acknowledge Disabled

0x22 0x23 ShuttleRev2 Acknowledge Disabled
Treated as N=1; 

Same as ShuttleRev1

0x20 0x30 Preroll Acknowledge Disabled

0x24 0x31 CueData Acknowledge Disabled

0x20 0x34 SyncPlay Acknowledge Disabled

0x21 0x38 ProgSpeedPlayPlus Acknowledge Disabled

0x21 0x39 ProgSpeedPlayMinus Acknowledge Disabled

0x40 0x11 OutEntry Acknowledge Disabled

0x44 0x14 InDataPreset Acknowledge Disabled

0x44 0x15 OutDataPreset Acknowledge Disabled

0x40 0x18 InFwd Acknowledge Disabled

0x40 0x19 InRev Acknowledge Disabled

0x40 0x1A OutFwd Acknowledge Disabled

0x40 0x1B OutRev Acknowledge Disabled

0x40 0x20 InReset Acknowledge Disabled

0x40 0x21 OutReset Acknowledge Disabled

0x40 0x22 AInReset Acknowledge Disabled

Supported RS-422 Commands
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Command Reply No Remote Notes

0x40 0x23 AOutReset Acknowledge Disabled

0x44 0x31 PrerollPreset Acknowledge Disabled

0x40 0x40 AutoModeOff Acknowledge Disabled
ignored, Status bit 

remembered

0x40 0x41 AutoModeOn Acknowledge Disabled
ignored, Status bit 

remembered

6 - Sense Request

0x61 0x0A TimeCodeGenSense

Request for Gen TC GenTCData Enabled

Timer1Sense Timer1Data Enabled

UserBitsVITCTimeSense UserBitsVITCTimeData Enabled

LTCUserBitsTimeSense LTCUserBitsTimeData Enabled

VITCUserBitsTimeSense VITCUserBitsTimeData Enabled

0x60 0x10 InDataSense InData Enabled

0x60 0x11 OutDataSense OutData Enabled

0x60 0x12 AInDataSense AInData Enabled

0x60 0x13 AOutDataSense AOutData Enabled

0x61 0x20 StatusSense StatusData Enabled

0x60 0x2E SpeedSense SpeedData Enabled

0x60 0x31 PrerollTimeSense PreRollTimeData Enabled

0x60 0x36 TimerModeSense TimerModeData Enabled

0x60 0x3E RecordInhibitSense RecordInhibitStatus Enabled

Supported RS-422 Commands
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Command Reply No Remote Notes

7 - Sense Reply

0x78 0x00 Timer1Data - -
Current Time and 

00:00:00:00

0x78 0x04 LTCUserBitsTimeData - -
Current Time and 

00:00:00:00

0x78 0x06 VITCUserBitsTimeData - -
Current Time and 

00:00:00:00

0x74 0x06 VITCTimeData - - Current Time

0x74 0x07 UserBitsVITCTimeData - - 00:00:00:00

0x74 0x08 GenTCData - - Current Time

0x78 0x08 GenTCUBData - -
Current Time and 

00:00:00:00

0x74 0x09 GenUBData - - 00:00:00:00

0x74 0x10 InData - -

0x74 0x11 OutData - -

0x74 0x12 AInData - -

0x74 0x13 AOutData - -

0x74 0x14 CorrectedLTCTimeData - - Current Time

0x70 0x20 StatusData - -
Please see “Status Bits” 
sheet: Limited to 9 bytes 

of status, silently truncated

0x71 0x2E SpeedData - -

0x74 0x31 PrerollTimeData - -

0x71 0x36 TimerModeData - - Returns 0 (TimeCode)

0x72 0x3E RecordInhibitStatus - -

Supported RS-422 Commands
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Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0

Byte 0 0 0 Cassette out 0 0 0 0 Local

Byte 1 Standby 0 Stop 0 Rewind Forward Record Play

Byte 2 Servo Lock 0 Shuttle Jog Var Direction Still 1

Byte 3 Auto Mode 0 0 0 Aout Set Ain Set Out Set In Set

Byte 4 Select EE Full EE 0 0 0 0 0 0

Byte 5 0 0 0 0 0 0 0 0

Byte 6 0 Lamp Still Lamp Fwd Lamp Rev 0 0 0 0

Byte 7 0 0 0 0 0 0 0 0

Byte 8 0 0 Near EOT EOT 0 0 0 0

Byte 9 0 0 0 0 0 0 0 0

Variables

Cassette Out Set if no SSD is present

Local Set if Remote is disabled (local control)

Standby Set if a disk is available

Direction Clear if playback is forwarding, set if playback is reversing

Still Set if playback is paused, or if in input preview mode

Auto Mode Set if in Auto Mode

Select EE, Full EE Set if in input preview mode

Lamp Still/Fwd/Rev Set according to playback speed and direction

Near EOT Set if total space left on available SSDs is less than 3 minutes

EOT Set if total space left on available SSDs is less than 30 seconds

HyperDeck Serial RS-422 Protocol

Protocol Based on Sony 9-pin protocol

Interface Baud rate 38.4 kBits/s

1 start bit

8 data bits

1 stop bit

1 parity bit

Odd parity

Others

Cue Complete (byte 2, bit 0) Always 1: Cue requests are always instantaneous

RS-422 Developer Information
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DISP
VIDEO

+12V POWERHDMI INHDMI OUTSDI INSDI OUT

4 5 6 7 8 93

1. Record
HyperDeck Shuttle will instantly record the moment you press 
the Record button, even if you’re playing back a clip. This 
means you’ll never miss a good take that’s happening. If the 
button flashes red, the SSD is too slow and cannot keep up 
with recording.

2. Previous Clip
If you hold down the Previous Clip, the clip will reverse at 
2x speed. Pressing the button again will increase the speed 
to 4x and 8x. If you want to resume playing back at normal 
speed, just press the Play button. Or you can press the Stop 
button to pause when reversing.

3. Stop
The Stop button also switches HyperDeck Shuttle between 
playback and video loop through mode.

4. Play
When a clip is playing, pressing Play again will loop it 
continuously.

5. Next Clip
If you hold down Next Clip, the clip will fast forward at 2x 
speed. Pressing the button again will increase the speed to  
4x and 8x. If you want to resume playing back at normal 
speed, just press the Play button. Or you can also press the 
Stop button to pause when fast forwarding.

6. DISP
This button isn’t currently used but will soon be enabled by a 
software update. You will be able to download this for free at 
www.blackmagicdesign.com

7. Power On/Off
The Power button turns the HyperDeck Shuttle on or off. To 
prevent someone from accidentally switching off the unit, 
you must hold the Power button down for 2 seconds to turn 
it off. If you’re running off the built-in batteries, the unit will 
turn itself off to conserve power after 8 minutes if you’re not 
recording.

8. VIDEO
The VIDEO indicator lights up when a video signal is detected 
by HyperDeck Shuttle.

9. SSD
The SSD indicator lights up in green when it is accessing a 
correctly formatted SSD. If the SSD has not been formatted 
correctly, or fails to work, the SSD light will illuminate solid 
red until the SSD is removed.

10. Battery
The four green battery indicators display the internal battery 
charge level. When all the LEDs go off, there’s approximately 
4 minutes of battery power left. So you should plug in 
your external power source or switch to another charged 
HyperDeck Shuttle.

1 2

Buttons Status Indicators

10

HyperDeck Shuttle Controls

http://www.blackmagicdesign.com
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DISP
VIDEO

+12V POWER HDMI IN HDMI OUT SDI IN SDI OUT

11 12 13 15 1614

11. +12V POWER
You can use the power adapter supplied with HyperDeck 
Shuttle or power it off an external camera battery as the 
connector supports an input range of 12V to 18V. When a 
power source is connected, the built-in internal battery will 
also be charged.

12. HDMI IN
You can connect your HDMI video sources to this input – such 
as a camera, games console or the output of a switcher.

13. HDMI OUT
Connect an HDMI display or TV to this output to monitor 
your video while recording or playing back clips. You can 
also connect this output to the HDMI input of capture cards, 
production switchers and other recording devices.

14. SDI IN
You can connect your SDI video sources, such as cameras, 
routers, capture cards, switcher outputs or decks to this input. 
A DIN 1.0/2.3 miniature connector is used for SDI input. A 
short DIN 1.0/2.3 to BNC adapter cable can be used to 
connect to SDI cables with BNC connectors.

15. SDI OUT
Connect this output to monitors, routers, production 
switchers, decks or other recording devices. A DIN 1.0/2.3 
miniature connector is used for SDI output. A short DIN 
1.0/2.3 to BNC adapter cable can be used to connect to SDI 
cables with BNC connectors.

16. USB 2.0
Use the USB Mini-B port for software configuration and 
updates.

17. Rubber Mat or HyperDeck Shuttle Mounting Plate
HyperDeck Shuttle has a non-slip rubber base for use on a 
desk. If you want to mount HyperDeck Shuttle on a camera 
or tripod, the base can be removed and replaced with an 
optional HyperDeck Shuttle Mounting Plate that is available 
for purchase from Blackmagic Design resellers.

SSD Slot
18. SSD Slot
Insert a 2.5" SSD into the SSD slot until you feel the SSD press 
into place. Hard drives are not supported and should not be 
used. To remove the SSD, simply pull it out.
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HyperDeck Shuttle Connections
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Installing the HyperDeck Shuttle Mounting Plate
HyperDeck Shuttle Mounting Plate is an optional accessory which lets you secure your HyperDeck 
Shuttle to a camera rig with your choice of rail mounts, cold shoe mounts, articulated arms and more. 
You can also use the plate to power your HyperDeck Shuttle from an external battery by attaching 
a V-Mount or Anton Bauer style battery plate. HyperDeck Shuttle Mounting Plate is available for 
purchase from Blackmagic Design resellers. For easy installation, please follow these simple steps.

Step 1. Peel back the rubber mat from all four corners of the base so you can just see the screws. 
Remove all four screws.

Step 2. Remove the base.

Step 3. Attach your HyperDeck Shuttle Mounting Plate using the supplied socket head screws.

1

3

2

4

1

3

2

4

1

3

2

4

Step 1 Step 2 Step 3

The contents of the box includes:

x1
HyperDeck Shuttle 
Mounting Plate

x4
Socket Head Screws 
M3 x 10mm

You will need:

x1
Hex Allen Key 2.5mm 
(not included)
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+12V POWER REMOTE ETHERNET SD/HD/3GHD-SDI HDMI

IN OUT

REF INMON OUTOUT 2OUT 1LOOP OUTIN

INPUTDISP

SET

REM

JOG

1. SSD Slot 1

2. SSD Slot 2
Insert a 2.5" SSD into an SSD slot until you feel the SSD press 
into place. The surround of the SSD slot lights in green when 
it is accessing a correctly formatted SSD. If the SSD has not 
been formatted correctly, or fails to work, the SSD slot light 
will illuminate solid red until the SSD is removed. Hard drives 
are not supported and should not be used. To remove the 
SSD, simply pull it out.

Buttons and Controls
3. DISP
This button isn’t currently used but will soon be enabled by 
a software update.

4. Previous Clip
Press once to go to the start of the current clip or press twice 
to skip back to the start of the previous clip.

5. Record
Recording commences the instant you press the record 
button, even if you’re playing back a clip, so you’ll never 
miss a good take that’s happening. If the button flashes red,  

the SSD is too slow and cannot keep up with recording.  
To switch from one SSD to the other while recording, press 
the record button for 1 second.

6. Next Clip
Press to skip to the next clip.

7. INPUT
While the stop button is illuminated, press the INPUT button 
once to display the incoming video on the LCD. If you don’t 
see the video you want, press the button again to switch 
between the HDMI and SDI inputs.

8. REM
Push REM to enable RS-422 remote control or to allow 
remote trigger recording via SDI.

9. SET
This button isn’t currently used but will soon be enabled by 
a software update.

10. Reverse
Press once to play in reverse at normal speed. Press again to 
reverse at 2x, 4x and 8x speeds.

11. Play
Press once to play through all clips or press again to loop the 
current clip.

12. Fast Forward
Press once to play at 2x speed or press again to play at 4x 
and 8x speeds.

13. Stop
Stop works in all modes.

14. JOG
Press once to use the jog wheel to scroll through video or 
press again to set the jog wheel to shuttle mode.

15. LCD
The color LCD displays video format, timecode, audio 
meters, video preview, transport controls and the active SSD.

16. Jog/Shuttle Wheel
Use with the JOG button to jog or shuttle forwards and 
backwards.

1 2 3 4 5 6 7 8

9 10 11 12 13 14 15 16

SSD Slots

HyperDeck Studio Controls
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+12V POWER REMOTE ETHERNET SD/HD/3GHD-SDI HDMI

IN OUT

REF INMON OUTOUT 2OUT 1LOOP OUTIN

INPUTDISP

SET

REM

JOG

17. +12V POWER
You can use the universal power adapter supplied with 
HyperDeck Studio or power it off any DC power source, 
from 12V to 18V, allowing for portable battery packs and on 
set use.

18. REMOTE
RS-422 remote control.

19. ETHERNET
This port isn’t currently used but will soon be enabled by a 
software update. 

20. SD/HD-SDI IN
You can connect your SD/HD-SDI video sources, such as 
cameras, routers, capture cards, switcher outputs or decks 
to this input.

21. SD/HD-SDI LOOP OUT
This output is reclocked from the video input and can be 
connected to other devices such as a monitor or a second 
HyperDeck for redundant recording.

22. SD/HD-SDI OUT 1
Connect this output to monitors, routers, capture cards, 
production switchers, decks or other recording devices.

23. SD/HD-SDI OUT 2
Connect this output to monitors, routers, production 
switchers, decks or other recording devices.

24. SD/HD-SDI MON OUT
SD/HD-SDI output for monitoring.

25. REF IN
This input accepts blackburst and tri-level sync signals from 
a sync generator.

26. HDMI IN
You can connect your HDMI video sources to this input – such 
as a camera, games console or the output of a switcher.

27. HDMI OUT
Connect an HDMI display or TV to this output to monitor 
your video while recording or playing back clips. You can 
also connect this output to the HDMI input of capture cards, 
production switchers and other recording devices.

28. USB 2.0
Use the USB Mini-B port for software configuration and 
updates.

Connections

282717 18 19 20 21 22 23 24 25 26

HyperDeck Studio Connections
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INPUTDISP

SET

REM

JOG

1. SSD Slot 1

2. SSD Slot 2
Insert a 2.5" SSD into an SSD slot until you feel the SSD press 
into place. The surround of the SSD slot lights in green when 
it is accessing a correctly formatted SSD. If the SSD has not 
been formatted correctly, or fails to work, the SSD slot light 
will illuminate solid red until the SSD is removed. Hard drives 
are not supported and should not be used. To remove the 
SSD, simply pull it out.

Buttons and Controls
3. DISP
This button isn’t currently used but will soon be enabled by 
a software update.

4. Previous Clip
Press once to go to the start of the current clip or press twice 
to skip back to the start of the previous clip.

5. Record
Recording commences the instant you press the record 
button, even if you’re playing back a clip, so you’ll never 
miss a good take that’s happening. If the button flashes red,  

the SSD is too slow and cannot keep up with recording.  
To switch from one SSD to the other while recording, press 
the record button for 1 second.

6. Next Clip
Press to skip to the next clip.

7. INPUT
While the stop button is illuminated, press the INPUT button 
once to display the incoming video on the LCD. If you don’t 
see the video you want, press the button again to switch 
between the analog, HDMI and SDI inputs.

8. REM
Push REM to enable RS-422 remote control or to allow 
remote trigger recording via SDI.

9. SET
This button isn’t currently used but will soon be enabled by 
a software update.

10. Reverse
Press once to play in reverse at normal speed. Press again to 
reverse at 2x, 4x and 8x speeds.

11. Play
Press once to play through all clips or press again to loop the 
current clip.

12. Fast Forward
Press once to play at 2x speed or press again to play at 4x 
and 8x speeds.

13. Stop
Stop works in all modes.

14. JOG
Press once to use the jog wheel to scroll through video or 
press again to set the jog wheel to shuttle mode.

15. LCD
The color LCD displays video format, timecode, audio 
meters, video preview, transport controls and the active SSD.

16. Jog/Shuttle Wheel
Use with the JOG button to jog or shuttle forwards and 
backwards.

1 2 3 4 5 6 7 8

9 10 11 12 13 14 15 16

SSD Slots

HyperDeck Studio Pro Controls
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POWER REMOTE

IN

SD/HD/3G-SDI IN SD/HD/3G-SDI OUT TIMECODE
IN OUT CH 1 CH 2 CH 1 CH 2

ANALOG AUDIO IN ANALOG AUDIO OUT

OUT
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Y IN B-Y IN R-Y IN R-Y OUT REF IN
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STEREO IN
B-Y OUTY OUT

IN B IN C IN D OUT A OUT B OUT C OUT D MON OUT
ETHERNET

PUSH PUSH

HDMI

PUSH

17. AC POWER
Connect an IEC power cord with a C13 connector.  
HyperDeck Studio Pro's built in international AC power 
supply supports 110-240V, 50/60 Hz.

18. USB 2.0
Use the type B USB port for software configuration and 
updates.

19. REMOTE
RS-422 remote control.

20. ANALOG VIDEO IN
Connect component analog sources such as older video 
decks and digitize analog footage. Use the Y input if 
connecting composite video.

21. ANALOG VIDEO OUT
Connect to any component analog output devices such 
as monitors, routers, production switchers, decks or other 
recording devices. Use the Y output if connecting composite 
video.

22. REF IN
This input accepts blackburst and tri-level sync signals from 
a sync generator.

23. RCA AUDIO IN
Stereo RCA connectors for unbalanced analog audio from 
consumer equipment.

24. ETHERNET
This port isn’t currently used but will soon be enabled by a 
software update.

25. THUNDERBOLT
Connect to a Thunderbolt port on a Mac OS X computer to 
capture video or perform live waveform monitoring.

26. HDMI IN
You can connect your HDMI video sources to this input – such 
as a camera, games console or the output of a switcher.

27. HDMI OUT
Connect an HDMI display or TV to monitor your video while 
recording or playing back clips. You can even connect a 4K 
HDMI display or TV to monitor 4K ProRes video playback.

28. SD/HD-SDI IN
You can connect your SD/HD-SDI video sources, such as 
cameras, routers, capture cards, switcher outputs or decks 
to this input.

29. SD/HD-SDI OUT
Connect to monitors, routers, capture cards, production 
switchers, decks or other recording devices. Use four 3Gb/s 
SDI outputs together for 4K ProRes video playback.

30. SD/HD-SDI MON OUT
SD/HD-SDI output for monitoring.

31. TIMECODE IN / OUT
Embed timecode to video recorded to SSD or send timecode 
to a separate source.

32. ANALOG AUDIO IN / OUT
Input and output connectors for professional balanced 
analog audio.

Connections

28 29 30 31 3227
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HyperDeck Studio Pro Connections
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Capturing video via Thunderbolt 
HyperDeck Studio Pro features Thunderbolt connectivity for the easy capture of uncompressed 
video to your computer with Thunderbolt technology. Thunderbolt offers a blazingly fast 10 Gb/s 
connection, which is enough bandwidth to handle the highest resolution video formats easily!

If you want to dub a video that you've already recorded to SSD, you can capture via Thunderbolt using 
the video software and codec of your choice.

Step 1. Connect HyperDeck Studio Pro via a Thunderbolt cable to your computer.

Step 2. Launch your video capture software, such as Media Express, Adobe Premiere Pro or AVID 
Media Composer.

Step 3. Make sure your capture software is configured to capture the same format as your source. 
e.g., 1080i/50, 720p/60.

Step 4. Press "Play" on HyperDeck Studio Pro.

Step 5. Click the capture button in your video software.

You can also simultaneously capture via Thunderbolt while recording to a SSD. This might be useful 
if you are recording a live event and are unsure if you have enough space on your SSDs to record 
the whole event. Alternatively, you may want to record in two different codecs, such as ProRes and 
DNxHD, simultaneously.

Step 1. Connect HyperDeck Studio Pro via Thunderbolt to your computer.

Step 2. Launch your video capture software, such as Media Express, Adobe Premiere Pro or AVID 
Media Composer.

Step 3. Make sure your capture software is configured to capture the same format as your source. 
e.g., 1080i/50, 720p/60.

Step 4. Press the INPUT button on HyperDeck Studio Pro to select the input from which you want 
to record to SSD and capture to your computer.

Step 5. Press Record on HyperDeck Studio Pro and click the capture button in your video software. 
You are now recording the same video input to both the SSD and to your computer.
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Editing with HyperDeck Studio Pro
When connected to a computer with Thunderbolt technology, HyperDeck Studio Pro can be used as a 
powerful capture solution for your editing workflow. The HyperDeck Installer software installs Blackmagic 
System Preferences which allow your favorite video editing software to perform live capture from HyperDeck 
Studio Pro via Thunderbolt. 

Video Capture
Remember to set the project preferences in your video capture software to match the video format playing 
back from HyperDeck Studio Pro. 

Once you have correctly configured the project preferences and set your application to capture, video will 
appear on your computer screen within a few seconds.

If you still can't see an image in your video capture software, quit out of the software and launch Blackmagic 
UltraScope. Make a note of the output video standard which is displayed on the left side of Ultrascope's 
Picture Display. Quit UltraScope, launch your video capture software and set the project preferences to 
match the standard reported by UltraScope.

Using Blackmagic System Preferences
Blackmagic system preferences provide a central location so you don't need to configure the same software 
settings in each video application that you use.

On Mac OS X, open the System Preferences and click the Blackmagic Design icon. When using HyperDeck 
Studio Pro, settings are grayed out and the main use of the Blackmagic system preferences is to tell you which 
version of Desktop Video software is installed for video capture via a Thunderbolt port.

When other Blackmagic video capture hardware is connected to your computer, additional settings may 
be available.

Blackmagic Design system preferences in Mac OS X
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Media Composer

Avid Media Composer 6.x
Avid Media Composer captures standard and high definition video live from HyperDeck Studio Pro via  a 
Thunderbolt cable. Blackmagic plug-ins for Media Composer are automatically installed if Media Composer 
is installed before the Desktop Video software.

You can use the INPUT button on HyperDeck Studio Pro to select your video and audio connections 
including SDI, analog and HDMI.

Setting up
Step 1. Launch Media Composer and the Select Project dialog box will appear.

Step 2. Choose your preferred User Profile if you have previously created one.

Step 3. Select the folder in which you want to create the project: Private, Shared or External.

Step 4. Click the New Project button.

Step 5. Type a project name and set the project options including Format and Color Space. Click OK.  
Once the project has been created, the frame rate and raster cannot be changed. The color 
space setting can be changed later in the Format tab of the project. 

Step 6. Double-click the project name in the Select Project dialog box. The Media Composer interface 
will appear along with the project window for your new project. You have completed setting up 
your project.

Step 5. Type a project name and set the project options.
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Capturing live via Thunderbolt
To capture video live via Thunderbolt from HyperDeck Studio Pro:

Step 1. Choose Tools > Capture to open the Capture Tool.

Step 2. Set the Video and Audio input menus to "Blackmagic".

Step 3. Select the video source track (V) and the audio source tracks (A1, A2, ...) you wish to capture.

Step 4. Use the Bin menu to select a Target Bin from the list of open bins.

Step 5. From the Res (resolution) menu, choose which compressed or uncompressed codec you wish 
to use for your captured clips. For maximum quality uncompressed video, choose "1:1" for 8-bit 
video capture or "1:1 10b" for 10-bit video capture.

Step 6. Select the disk storage for your captured video and audio. Use the Single/Dual Drive Mode 
button to determine if video and audio will be stored together on a single drive or video on one 
drive and audio on another drive. Select the target drive(s) for your captured media from the 
Target Drives menu(s).

Step 7. Click the "Tape Name?" button at the bottom of the window to open the Select Tape dialog box. 
Select the desired tape, or add a new one, and then click OK.

Step 8. Ensure your video and audio source is ready or playing and then click the Capture button or press 
the F4 key. The Capture button will flash red while recording. Click the Capture button again or 
press the Escape button on your keyboard to end the capture.

Step 2. Set up the Capture Tool to capture video by clicking the 
Toggle Source button.
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Final Cut Pro 7

Select a Blackmagic Easy Setup

Apple Final Cut Pro 7
Easy Setups for Final Cut Pro 7 are automatically installed if Final Cut Pro is installed before the HyperDeck 
software. 

Setting up
Step 1. Launch Final Cut Pro 7 and the Easy Setup window will appear.

Step 2. Click on the popup menu and select the desired Blackmagic Easy Setup. For each video format 
(NTSC, PAL and HDTV) you will find a range of Blackmagic compressed and uncompressed file 
formats you can choose.

Step 3. Click on the popup menu named Primary Scratch Disk and select your disk array from the popup 
menu.

Step 4. Click OK and the Final Cut Pro interface will appear.

Capturing Live via Thunderbolt
To capture video live via Thunderbolt from HyperDeck Studio Pro:

Step 1. Select a Blackmagic Easy Setup. Final Cut Pro will sometimes warn that device control has been 
set to “non-controllable device”. This is as expected. Click OK and then create a project with 
these settings.

Step 2. Choose File > Log & Capture. (Command + 8).

Step 3. Press play on HyperDeck Studio Pro and then press the Now button in the Log and Capture 
window. Final Cut Pro will show you a preview of the video you are capturing.

Step 4. Press the ‘esc’ key at the top left of your keyboard to stop capturing.
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Adobe Premiere Pro CS6

Setting up a Blackmagic Design project
Step 1. Launch Premiere Pro.

Step 2. Create a New Project and click on the Scratch Disks tab.

Step 3. Set the desired Location and Name for your project at the bottom of this window.

Step 4. Set the locations for your captured video, captured audio, video previews and audio previews.

Step 5. Set the Capture Format to Blackmagic Capture and click on the Settings button to reveal the 
Blackmagic Capture Settings for your project. The Video Standard can be set to NTSC, PAL, 
HD720 or HD1080. The Video Format can be uncompressed or compressed. Now click OK.

Step 6. The New Sequence window will appear. To preserve maximum video quality, you'll need to create 
a full resolution uncompressed sequence. To do so, click the discovery triangle next to "Blackmagic 
Design", select a preset to match the video standard and choose from uncompressed 8 bit YUV, 
10 bit YUV or 10 bit RGB. If you don't have the storage space or disk speed for uncompressed 
video, choose a JPEG sequence preset for a full resolution, open-standard codec.

 When you have selected the desired sequence preset, give the sequence a name and click OK.

Capturing Live via Thunderbolt
To capture video live via Thunderbolt from HyperDeck Studio Pro:

Step 1. Choose: File > Capture [F5]

Step 2. Press play on HyperDeck Studio Pro and then Click the red record button [G]. A preview of the 
video you are capturing will appear.

To change the capture format, click on the Settings tab and then the Edit button. Ensure the Capture Format 
is set to Blackmagic Capture, click on the Settings button and then change the Blackmagic Capture Settings 
as desired.

Adobe Premiere Pro

Capture
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Adobe Photoshop CS6

How to grab video frames

Import an image into Photoshop
Step 1. From Photoshop select File > Import > Blackmagic Image Capture

Step 2. Select the “Video Input Format” and the “Image Bit Depth” and then click Capture Image

Once you have set the options in the Import window, each subsequent import will not display the window, 
so you can grab frames much faster. However if you would like to change your import format, hold the 
Option key when selecting import.Adobe Photoshop

Image Capture
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What is Media Express?
Blackmagic Media Express 3 software is included with every HyperDeck Studio Pro to perform video and 
audio capture to files. Blackmagic Media Express 3 is a great tool when you don’t need the complexity of 
NLE software, but simply want to capture video from HyperDeck Studio Pro's Thunderbolt port.

The User Interface
Media Express can easily be scaled for different sizes of monitors or even small notebook screens. When 
you open Media Express, you'll notice the log and capture, playback and edit to tape views are color-coded 
so you will know at a glance which mode is being used. The edit to tape view is not used by HyperDeck 
Studio Pro but may be used with other Blackmagic Design capture and playback products.

Media List
The left "media list" always displays the scratch, any bins you have created and also any media you have 
imported or captured. Media can be displayed in Timecode List view or Thumbnail view and you can even 
filter media by favorites. The Search field makes it easy to find media by name or by attributes captured 
in the media metadata. The project name and format are shown in the bottom-left corner of the Media 
Express window.

The top-right pane always displays the video preview. Timecode is displayed at the top of the video  
preview pane.

Log and Capture
Click on the red Log and Capture tab. The video preview pane shows the source video from HyperDeck 
Studio Pro. Here you can enter metadata for the clips you will capture including name, description, favorite 
and more. Double-clicking a captured clip in the media list will automatically switch Media Express to 
Playback view.

Playing back captured clips
In the green Playback view, the video preview pane shows the video of the clip being played. Click the 
favorites button to add to your favorites in the media list.
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Capturing Video and Audio files
Selecting HyperDeck Studio Pro
If you have more than one Blackmagic Design capture product installed or connected to your computer,  
go to the Device menu in Media Express and select HyperDeck Studio Pro. In the example pictured on 
this page, an Intensity Extreme and a HyperDeck Studio Pro are both connected to the same computer. 
Selecting your HyperDeck Studio Pro will allow you to choose suitable video settings for your project.

Setting up a Project
Before capturing any clips in Media Express, you will need to select the settings for your project. Go to 
Media Express>Preferences on Mac OS X. Any settings which are grayed out are only used with other 
Blackmagic Design capture products and are not required by HyperDeck Studio Pro.

Set the project video format to HD1080p and also set the frame rate. Select from a range of professional 
compressed and uncompressed capture file formats or even a DPX image sequence. Video will be captured 
in the chosen format and saved to a QuickTime movie on Mac.

Set the storage location for your captured video and audio and choose whether to stop capture or playback 
if dropped frames are detected.

Usually video applications stop playing video if you send them to the background. If you want Media Express 
to keep playing video, even if you open another application in the foreground, enable the checkbox to 
"Continue playback when in the background."

The final options for pre-roll and frame timecode offset are not used by HyperDeck Studio Pro when 
capturing video via a Thunderbolt connection. They relate to tape decks with RS-422 deck control.

Select your HyperDeck Studio Pro from the Device menu.
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Capture
Capturing video is easy. All you need to do is connect HyperDeck Studio Pro via a Thunderbolt cable, set 
the Media Express preferences and press the Capture button.

Start by connecting your video source to an input of your HyperDeck Studio Pro and check that the video 
input is set to the same video input, e.g. SDI, HDMI or analog.

Open Media Express and set its preferences to the project video format and capture file format. The project 
video format must be set correctly otherwise you will not see your video in the preview pane.

Click the red Log and Capture tab and enter a description for your video into the Description field of the 
logging information area.

Click the "+" button next to the Description to add it to the automatic Name field. Click the "+" button next 
to any of the other fields that you wish to add to the Name field.

•	 You can increment the value in each of these fields by clicking on the corresponding clapper 
board icon. Alternatively you can type directly into any field to customize its name and number.

•	 The text in the automatic Name field will be applied to the clip(s) which are about to be 
captured.

•	 Click the "star" icon next to the Name field if you want to log the clip as a favorite.

•	 Click the "!" icon next to the Name field if you wish a clip name confirmation prompt to appear 
before every capture. This will provide you with the chance to change the clip name.

Set the desired number of audio channels to be captured and then click the “Capture” button to start 
recording. 

To end capture, click the “Capture” button again to automatically keep the clip. Alternatively press the 
“Esc” key if you want to be prompted to delete or save the clip.

The captured clips will be added to the Media List.

Set the desired number of audio channels to be captured

Enter a description for your video

Click the Capture button to commence recording
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DPX Capture
If you want to capture a DPX image sequence rather than a movie file, open the Media Express preferences 
and set the Capture File Format to DPX 10-Bit RGB. You will need a fast disk array to cope with the 
uncompressed, 10-bit RGB format.

 � Create a DPX project by setting the capture file format to DPX.
 � Capture.

When the capture has been completed, a single thumbnail will appear in the Media List representing the 
entire frame sequence. The sequence of DPX frames will be stored in its own folder in your disk storage. 
Audio will be stored in a .wav file in the same folder.

By default, DPX captures are assumed to be from YUV sources. If you need to capture from an RGB source, 
disable the "Capture to DPX from a YUV source" option otherwise your DPX files will show weird pink and 
green colors.

If you want the DPX frame numbers to be based on the timecode of the captured video, rather than just 
starting from zero, enable the option to "Use absolute frame numbering when capturing DPX".

If you aren't performing long DPX captures, you may wish to reduce the number of zeroes in the frame 
numbers by changing the option, "When capturing DPX files, use (2-8) digit numbers in the frame count.

DPX capture preferences
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Playing back Video and Audio Files
Importing clips
You can play back your video and audio files after importing media into Media Express in any of  
the following ways:

 � Double-click an empty area of the Media List.
 � Right-click an empty area of the Media List and select Import Clip from the contextual menu.
 � Go to the File menu, select Import and then Media Files.

Then select the video and audio clip(s) you wish to import from the Open Video Clip dialog box. The clips 
will appear in the Scratch area of the Media List. If you have created your own bins in the Media List, you can 
drag the clips into the desired bin.

If you want to import media directly to a bin, right-click within the desired bin and select Import Clip from 
the contextual menu.

If the files being imported do not match the frame rate and size of existing clips in the Media List, you will 
be prompted to create a new project and to save the current project.

Media Express also supports the import of multichannel audio-only files recorded at 48kHz in the 
uncompressed WAVE (.wav) and AIFF (.aif) formats.

Another way to import media is to use an XML file which has been exported from Final Cut Pro 7. Go to the 
File menu, select Import and then Final Cut Pro XML. Open the desired XML and all the bins and media 
from the Final Cut Pro project will appear in the Media List.

Playing back single and multiple clips
To play back a single clip, double-click the clip in the Media List. Alternatively select the clip in the Media List 
and press the space bar on your keyboard or the play button in the transport controls.

To play back multiple clips, select the clips in the Media List and then press the space bar on your keyboard 
or the play button in the transport controls.

There are three ways to import clips into Media Express

You can use the transport controls to play, stop, jump to the next 
or previous clip and loop playback of your clips.
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Browsing Media
In the Media List, you can view your clips in Thumbnail view or Timecode List view by clicking on the desired 
view button at the top-right of the Media List.

Thumbnail view
Thumbnails are the most intuitive way to display your clips. To get information for a clip, hover your mouse 
over the clip's thumbnail and then click on the popup info icon which will appear at the bottom-right of the 
thumbnail. Click the info bubble to hide it.

List view
You can view your clips in Timecode List view by clicking on the Timecode List button at the top-right 
of the Media List. Use the horizontal scroll bar at the bottom of the Media List to view all the columns of 
information for your clips including: in and out points, video format, audio channels, field dominance and 
logging information.

Creating and using bins
To create a bin for your clips, right click an empty spot in the Media List and select "Create Bin". Type in a 
name for the new bin.

You can move clips from the Scratch, or from one bin to another, by dragging the clip icons to the desired 
bin. If you want a clip to appear in more than one bin, import the same clip again by right-clicking on the bin 
and choosing "Import Clip".

By default, logged clips appear in the Scratch. If you want to log clips and have them appear in a new bin, 
right-click the new bin and choose "Select As Log Bin".

Creating and using favorites
In the Log and Capture tab, click the "star" icon next to the Name field if you want to log a clip as a favorite.

In the Playback tab, clicking the "star" icon will make the clip a favorite if it is selected in the Media List. Click the 
"star" icon again to deselect it as a favorite.

Clips marked as favorites will show a yellow star in their icon in Timecode List view and Thumbnail view.

In the Media List, choose to view your clips in Timecode List view 
or Thumbnail view. Click the Favorites button to only show your 
favorite clips. Type in the Search field to find your favorite clips.

Click the popup info icon on a thumbnail to view its info bubble.

Clips marked as favorites are easily identified by the yellow star in 
their icon.
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Once you have marked clips as favorites, click on the gray, Favorites, star button at the top of the Media 
list and it will turn yellow. All clips in your Media List will be hidden except for those marked as favorites.  
This is similar to creating a playlist and makes it easy to only play back your favorite clips and even master 
them to tape.

Deleting clips and bins
To delete clips, select the unwanted clips and press the forward delete button on your keyboard. This will 
only delete the clips from the Media List and they will safely remain on your disk storage.

To delete bins, right-click within a bin and choose "Delete Bin". This action will delete the bin and any clips it 
contained. This will only delete the clips from the Media List and they will safely remain on your disk storage.

Searching the Media List
Clips can easily be found in a project by typing the name of your clips in the Search field at the top of the 
Media List. When used in conjunction with the favorites feature, the search will be confined to your favorite 
clips so you will see a shorter list of found clips.

In the Log and Capture tab, click the "star" icon next to the 
Name field if you want to log the clip as a favorite.

In the Playback tab, clicking the "star" icon will mark a clip as a 
favorite if it is selected in the Media List.

Click the Favorites button at the top of the Media List to only 
show your favorite clips. Type in the Search field to find clips.
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What is Blackmagic UltraScope?
With HyperDeck Studio Pro you get the incredible features of Blackmagic UltraScope, which you can 
even use with compatible Mac OS X and Windows notebook computers with Thunderbolt technology! 
Blackmagic UltraScope software is installed by the HyperDeck Studio Pro Installer. 

Previously broadcast quality television and post production scopes were incredibly expensive custom 
solutions that only let you see one scope at a time on a tiny screen! Some scopes look ugly and don’t really 
look good in front of your client. With Blackmagic UltraScope, you get 6 wonderful scopes that let you see 
all aspects of your video signals! 

Blackmagic UltraScope is perfect for quality control checks of the output of your HyperDeck Studio Pro no 
matter which video input you use. Simply connect a Thunderbolt cable between your HyperDeck Studio Pro 
and a Thunderbolt enabled computer and away you go! 

Installation Requirements
HyperDeck Studio Pro connects to both Mac OS X and Windows computers with Thunderbolt technology. 

The Blackmagic UltraScope software interface requires a computer display with a minimum resolution of 
1280 x 800 pixels to view two scopes simultaneously. Blackmagic Design recommends viewing all 6 scopes 
simultaneously by using a computer display resolution of 1920 x 1200 or 1920 x 1080 pixels. 

Please see the support pages at www.blackmagicdesign.com for a comprehensive list of the latest, minimum 
system requirements for Blackmagic UltraScope for Mac OS X and Windows. 

http://www.blackmagicdesign.com
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1. Parade Display 2. Waveform Display 3. Vectorscope Display

4. Histogram Display 6. Audio Metering Display 7. Picture Display

5. Error Logging

Blackmagic UltraScope Interface
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Understanding Blackmagic UltraScope Views
Blackmagic UltraScope has two different views available depending on your workflow needs and screen 
resolution. You have the choice of viewing six displays in “Full Screen” view, or for more compact viewing, 
choose any 2 displays in “2-up” view.

The display view can be selected from the View menu.

Choose Full Screen to enter “Full Screen” view. If this option is unchecked, “2-up” view will be displayed. 
You can quickly switch between Full Screen view and 2-up view by using the hot key CMD-F on Mac OS X.

In “2-up” view, select the desired left and right scopes by opening the View menu or by right-clicking 
anywhere in the UltraScope window. Make your selections from the Left View and Right View menu 
options. If you attempt to choose the same scopes for both the Left View and Right View, the existing 
scopes will swap sides.

Screen Resolution Requirements for Display Views
 � Full Screen view: 1920 x 1200 pixels or 1920 x 1080 pixels. If your monitor doesn’t support these 

resolutions, then Full Screen view will not be available.
 � 2-up view: minimum resolution of 1280 x 800 pixels.

Full Screen view

2-Up view
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Zoom Function
Blackmagic UltraScope allows you to zoom in on various displays for a more detailed analysis.  
This helpful function will also pan and zoom the graticules for each display in high resolution.

The zoom function is available in the Parade, Waveform, Vectorscope and Picture displays.

To zoom in, simply click on the bottom right of each respective display. Now you will be able to 
view the display in finer detail. Drag the mouse within the display area to pan around the zoomed display. 
Clicking again, will return the display back to its normal view.

1. Parade Display
Parade Display is perfect for checking for illegal colors and checking levels.

Press the RGB button to display the full height of each color channel as red, green and blue. Monitoring the 
levels of each red, green and blue color channel makes it is easy to view color balance in the blacks, mids 
and whites of the video signal. Parade Display enables you to identify details common to the red, green and 
blue channels.

It’s often important to make sure you’re not clipping the video levels. Make sure the video is full level but 
not clipped. You can turn on the GAMUT function, and any illegal levels will be highlighted in bright red,  
so they are easy to see. Instructions for setting gamut limits can be found in the Error Logging Display 
section of this manual. If you want to increase the video level, then make sure it doesn’t go above upper 
RGB limit or you will encounter illegal levels. Some equipment won’t let you generate illegal 100% RGB 
levels, however other equipment will. Blackmagic UltraScope lets you see illegal levels whenever they occur.

Illegal video can also happen in blacks as well as whites. Some equipment produces black levels which 
can be lowered below the black point of 0%. The levels will be shown as bright red if this falls below the 
lower gamut limit and the GAMUT warning mode is enabled. If you observe illegal black levels, just add 
some “lift” or gain to eliminate them but check the 100% graticule level to make sure the whole video 
signal has not lifted and generated illegal colors in the whites.

To check levels, simply press the YUV or YUV+ button.

The COLOR setting switches the RGB display to color rather than traditional black and white. When the 
COLOR setting is used with the YUV or YUV+ display, luma (brightness) remains white, B-Y (difference 
between blue and luma) appears blue and R-Y (difference between red and luma) appears red. The COLOR 
setting is not a professional setting and should usually be switched off, especially when showing video  
to clients.

Zoom button

Zoom Function

Parade Display



Using Blackmagic UltraScope52

2. Waveform Display
The Waveform Display is similar to traditional composite waveform monitors seen in many broadcast 
studios. On Mac OS X, the Waveform Display always shows the luminance view and the B/W button is 
permanently selected. On Windows, select B/W for the luminance only view, COMP for the composite only 
view, and BOTH for the twin luminance and composite view.

Select B/W for the luminance view which provides a digitally encoded waveform similar to traditional 
luminance waveform monitors. The luminance view is very useful when adjusting luma (brightness) levels in 
an image. Turn on the GAMUT function, and any illegal luma levels will be highlighted in bright red, so they 
are easy to see. Instructions for setting luma limits can be found in the Error Logging Display section of this 
manual. Traditional luminance waveform monitors only supported composite analog standard definition 
video. However UltraScope’s luminance view works in high definition as well as standard definition, so 
you have a consistent and easy way to adjust luma levels even when monitoring high definition digital  
video formats!

For Windows users, the composite view is exciting because it’s a fully digitally encoded composite waveform 
view and similar to a traditional waveform monitor. This provides a much easier way to align to test signals, 
such as color bars, because you can use the composite waveform exactly the same way as it has always been 
used. Composite view also works in high definition, so you have a consistent and traditional way to adjust 
video even when working in high definition!

When BOTH view is selected on a Windows PC, the composite and luminance waveforms display side by 
side in a twin view. This is incredibly useful when adjusting video levels or color correcting. It’s impossible for 
a vectorscope to show which objects in the video have color because a vectorscope just shows what colors 
are in the whole image and not which objects have color. When color correcting, you often need to look for 
specific parts of the image, remove the color and produce a neutral state. This is because the composite 
waveform is the same as the luminance signal but with chroma added.

Choosing this twin view makes it easy to identify similar items in the luminance and composite waveforms, 
and if more blur or chroma is observed in the composite area, the item has color. If some part of the 
video image is neutral gray, then it should look the same on both waveforms because no chroma will 
be present. With the twin view, you can look around the waveform and see the levels of color or chroma 
of various objects. As you color correct, the composite waveform will display more or less chroma in 
the video signal. Now you can see if specific objects in the video image are color or black and white.  
You can make technical and creative decisions using the Waveform Display.

When the Waveform display is zoomed in, you can toggle between COMP and B/W, and view the same 
region of an image in the zoomed display.

Waveform Display on Mac OS X always shows Luminance view.

Waveform Display on Windows can show Luminance, Composite 
or Both views.
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3. Vectorscope Display
The Vectorscope Display uses a vector view to show the colors in a video signal. You can see color bar 
video levels by using the color boxes in the graticule. All you need to do is select 75% or 100% color bars, 
depending on the standard of color bar test signals used in your facility!

Some people think you can use a vectorscope to check for illegal levels. However this is not correct and the 
Parade Display should be used, and set to RGB, for checking for illegal colors. The reason you cannot use a 
vectorscope to check for illegal levels is that both chroma and luminance values are required. For example, 
colors near the white or black points in video cannot be as saturated as the much stronger colors, which 
can be used in the mid-grays. Because Vectorscope Display only shows colors, and not luminance values, it 
cannot be used to check for illegal colors.

Vectorscope Display is the best tool for checking color levels from older, analog videotape where you need 
to adjust chroma levels. Just play back the color-bar segment of the videotape, and then adjust the chroma 
and hue settings, to set the colors of the video within the square boxes in the graticule.

Vectorscope Display is also perfect for color grading, as you can easily see if your video is correctly white-
balanced or if there is a color tint. If your video has a color tint, the Vectorscope display will drift off-center, 
and you might see two center dots. Normally the blanking in the video signal will create a dot in the center 
of the vector scope, and this is because the blanking in the video is black video without any color. Blanking 
provides a useful reference point to help recognize areas of black video without any color information.

If your video has a color tint, you should see the blacks move off-color and off-center. The degree of shift 
represents the amount of color tint in your video and you can see the shift in both the white and black 
details of your video. This makes Vectorscope Display valuable for removing color tint and regaining correct  
white balance.

Vectorscope Display lets you push colors in your video to the limits, without accidentally adding unwanted 
color tints to blacks and whites. While color balance can be monitored on both the RGB Parade Display and 
Vectorscope Display, color balance issues will often be easier to see in Vectorscope Display.

Vectorscope Display
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4. Histogram Display
Histogram Display is most familiar to graphic designers and camera operators. Histogram Display shows 
the distribution of white to black information and lets you monitor how close the detail is to being clipped 
off in the whites or blacks of the video. Histogram Display also lets you see the effects of gamma changes 
in the video.

Black video is shown on the left of the display, and whites are shown on the right. All video should usually 
be found between the 0% and 100% intervals of the Histogram Display. Your video is being clipped if it 
moves below 0% or above 100%. Video clipping can be really bad, when you’re on a shoot, as detail in the 
blacks and whites must be preserved if you subsequently want to perform color-correction in a controlled 
environment. When shooting, keep the video above the black clip, and below the white clip, so you can 
have more freedom later to adjust colors without whites and blacks appearing flat and lacking in detail.

When color-correcting, you might decide to clip your video, and in which case Histogram Display will show 
the effect of clipping the video, and how much it is being clipped. You can even use gamma to create a 
similar look, with less clipping, while retaining more detail.

You cannot really use Histogram Display to check for illegal levels although you can use it to see illegal 
blacks and whites. Histogram Display does not show colors and so the histogram might appear to show 
legal levels, even though your video may contain illegal colors. Again, RGB Parade Display provides the 
best way to watch out for illegal levels as it shows them in both the color and luminance elements of the 
video signal.

The HIGH and LOW buttons simply control how bright the histogram appears on your computer display.  
If you find the white area of the histogram is too bright in a dark studio, choose LOW for a more comfortable 
brightness level.

Histogram Display
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5. Error Logging Display
Error Logging records errors in video and audio and is indispensable when reviewing video and for 
unattended operation. Errors may be logged for color, brightness or audio threshold levels as well as loss 
of video signal, change of video format or audio silence. After setting the parameters which define when an 
error should be logged, you can choose to start or stop error logging, save the log to a file, or clear the log. 
These functions can be selected from the buttons in the Error Logging Display or from the Error Logging 
pulldown menu.

Errors are recorded against timecode and time of day to make them easy to find. If the timecode is not 
present, errors can be found by reviewing the time of day at which they were recorded. As computer clocks 
can drift, it is a good idea to inspect the Date & Time settings on your computer, and set the clock to 
synchronize with an Internet time server to ensure accurate time of day logging.

In the Full Screen view, Histogram Display and Error Logging Display share the same area of the UltraScope 
interface. Select the LOGGING button, below the Histogram Display, to switch to the Error Logging Display. 
Select the HISTOGRAM button, below the Error Logging Display, to switch back to the Histogram Display. 
After quitting and reopening the UltraScope application, the last viewed display will be made visible again, 
i.e. either Histogram or Error Logging. 

In 2-up view, Histogram Display and Error Logging Display can be viewed simultaneously and so there are 
no LOGGING or HISTOGRAM buttons.

When viewing the Error Logging Display for the first time, the display will initially be blank other than for 
some column headings. Select the START button to commence logging. In Full Screen view, you can switch 
back to the Histogram Display and UltraScope will continue to perform error logging until you choose to 
stop it.

When error logging is being performed, the STOP button replaces the START button. When the STOP 
button has been selected, you can choose to START again and any new errors will be appended to the 
existing log. When error logging has been stopped, you can choose to SAVE the log to a CSV file or 
alternatively CLEAR the log. The SAVE and CLEAR buttons will not appear if no errors have been recorded. 
The CSV file can be analyzed in many applications including spreadsheet and database software.

By default, error logging is performed using the EBU-R103 standard which is set down by the European 
Broadcasting Union. This standard is popular worldwide and is commonly used as a template for making 
new error logging profiles.

From the Histogram Display, select the Logging button to switch 
to the Error Logging Display.
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How to Customize Error Logging
To customize error logging, go to the Error Logging menu and choose Profiles to open the Error Logging 
Profiles window. Saved profiles appear in the profile list at the left and the current, active profile appears in 
bold above the list.

The standard EBU-R103 profile cannot be deleted or modified and is grayed out. You can add a profile by 
clicking the add (+) button and typing a name for your profile. The new profile will initially contain the same 
parameters as the EBU-R103 profile but these can be changed as required.

Under the Gamut tab, upper and lower limits can be adjusted as a percentage of IRE units for RGB, Luma 
and Chroma. Set the minimum time in milliseconds (ms) for which these conditions must be sustained 
before being logged as errors. Set the percentage area, of pixels in error to total pixels in a frame, below 
which errors can be ignored. The Area setting acts like sensitivity.

Under the Audio tab, the maximum audio level can be set in decibels (dBFS) as can the audio level below 
which audio is regarded as silence. Set the minimum time in milliseconds (ms) for which these conditions 
must be sustained before being logged as errors.

Under the Video tab, loss of video signal and change of video format can be logged as errors.

Under the Notes tab, write a brief description of the new profile to help distinguish it from other profiles.

To modify a new or existing profile, ensure it is selected and then change its parameters as desired. Press 
Save to save these changes or choose Revert to leave the profile unchanged.

Choosing Save saves the changes to the profile but does not determine which profile is active. To activate 
a profile, select it from the profile list and then choose Set Active.

You can delete a profile by selecting it in the profile list and clicking the delete (–) button.

Gamut error tolerance settings for color and brightness

Audio error tolerance settings
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6. Audio Metering Display
Audio Metering Display shows you the audio levels in the embedded audio of the HyperDeck Studio Pro's 
video signal. 8 channels of embedded audio from your HyperDeck Studio Pro are de-embedded and then 
displayed in either dBFS or VU format. The VU button switches between dBFS and VU audio metering 
standards.

dBFS is essentially a meter of the overall digital audio signal and is common on modern digital equipment.

The VU meter shows average signal levels, is easy to use and very common on older equipment. VU is 
calibrated to the SMPTE recommendation of a 1 kHz tone test signal set to -20 dBFS.

The right hand audio scope can monitor two channels of audio. The audio scope presents audio in an X-Y 
view so you can see audio balance issues, out of phase conditions and whether an audio track is mono 
or stereo. Mono audio should appear as a single, vertical, “in phase” line. If the line is horizontal, then  
your audio is “out of phase” and could cancel out (i.e. loss of audio) when received by downstream 
equipment. Audio phase is one of the most common audio faults in large facilities, where cables can be 
incorrectly connected.

When monitoring stereo audio, the Audio Metering Display will puff out a little like a flower, highlighting the 
difference between the left and right audio channels. The more stereo sound is contained in the audio track, 
the more circular the display will appear. If the audio contains minimal stereo content, then the display will 
appear more concentrated around the vertical axis.

While spoken dialog tends to appear as a vertical line, music with plenty of stereo content will puff out.  
This is because mono audio is L+R, and will display on the vertical axis, whereas stereo content is L-R, and 
will display on the horizontal axis to show the stereo difference.

Audio Metering Display
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7. Picture Display
The Picture Display is a handy confidence monitor so you can see the video that is being received  
by Blackmagic UltraScope. The Picture Display has three settings: COLOR, B/W (black & white) and BLUE 
(Blue Only).

Set to COLOR or B/W depending on the needs of your facility. Black & white is popular for use in color-
correction studios so clients don’t get confused when seeing multiple color displays, and not understanding 
which color display is the correct, color-calibrated display. You may wish to select B/W so there is only a 
single, calibrated, color display in the room. The black & white display can also provide a useful visual 
reference.

Blue Only is used with color bar test signals for setting hue on playback decks. When adjusting hue, make 
sure all the blue bars are a constant brightness to attain the correct hue level.

Blue Only can also be used for evaluating noise levels in cameras and telecines. Blue has the least amount 
of signal level, in a color video signal, and so is more susceptible to noise. The BLUE setting can provide a 
good way to check on noise levels in a video signal.

The Picture Display will also decode RP-188 HD and VITC SD timecode information, from an SDI video input 
signal, and display it on the right side of the display. If the timecode information is incorrect, check your deck 
to ensure it is outputting the correct timecode signal encoded as VITC or RP188.

It is worth noting that some standard definition broadcast decks let you “re-stripe” the timecode track 
independently of the VITC, which was encoded as part of the image. This meant the VITC could not be 
changed without copying the video down another generation. Consequently some standard definition 
decks had different timecode in the VITC to the normal LTC track on the SDI video output. It is always worth 
checking master tapes if you think the displayed timecode is incorrect.

The Picture Display will also show timecode internally generated by your HyperDeck Studio Pro when 
Generate is selected in the Ancillary Data>Timecode>Mode Select menu.

Lastly, the video standard is displayed on the left side of the Picture Display, so you can verify the video 
standard being output by your HyperDeck Studio Pro. This information is great for independently checking 
that the correct video standard is being output without having to use external monitoring equipment. If the 
displayed video standard is not what you expected, you should check the output settings on HyperDeck 
Studio Pro.

Picture Display
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Using Blackmagic Design Disk Speed Test
Blackmagic Disk Speed Test is a beautiful and fun to use application that measures the read and write 
performance of storage media in video frame sizes. The use of video frame sizes provides accurate 
measurement of how the disk storage will perform with video related applications. 

If you have ever wondered whether your hard drive is suitable for playback (“read”) of a particular video 
format, you can use Disk Speed Test to find out. With its easy to understand layout, it is now simple to 
understand what performance you can get out of your media drives with a single click of the Start button! 
Disk Speed Test will even show you how many streams of video your storage is capable of handling!

Disk Speed Test is included free with your HyperDeck and can also be downloaded from our website free 
of charge.

Disk Speed Test takes the guess work out of configuring your storage system for optimal performance for 
any job you will be doing.

Disk Speed Test settings are accessed by clicking on the Settings button, just above the Start button.  
On Mac OS X, the same settings are also available from the Menu Bar at the top of your computer display.

Select Target Drive
Click Select Target Drive to choose the storage volume you wish to test. Ensure you have Read and Write 
permissions for the selected volume as Disk Speed Test will write a temporary file to it. This file will be 
automatically deleted when you quit Disk Speed Test.

Save Screenshot
After testing your disk storage, click Save Screenshot to save a screenshot of the results to a chosen location. 

Stress
Lower stress settings may be chosen if you want to demonstrate the speed of disk storage quickly. The  
1 GB option would be a good choice on a trade show booth to rapidly show the read and write performance 
of a disk array even though the results might not be quite as accurate as when the 5 GB option is selected.

Disk Speed Test limits each write operation to a maximum of 8 seconds and each read operation to a 
maximum of 8 seconds so you do not have to wait long to obtain results.

Disk Speed Test Help
Click Disk Speed Test Help to launch the PDF manual for Disk Speed Test. 

About Disk Speed Test
About Disk Speed Test displays which version of the Disk Speed Test you are running.

Settings menu
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How Fast? 

This panel shows results 
in frames per second (fps)

Settings 

Click this button to 
access the settings before 
running a disk speed test

START

Click this button once to 
start the disk speed test. 
Click again to stop the test

Will it Work? 

This panel shows which 
video formats can be 
supported by your disk 
storage
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Start
Once you have chosen the desired settings, click the Start button to commence the disk speed test.  
Disk Speed Test will write a temporary file to the selected target drive. When the file has finished writing, 
or when 8 seconds has elapsed, Disk Speed Test will stop writing and start reading back the temporary file 
from the drive.

Disk Speed Test will continue writing and reading the nominated sized stress file until you stop the test by 
clicking the Start button again.

Will it Work?
The “Will it Work?” panel can help to identify video formats where the Read performance might be 
significantly different to the Write performance. These differences might mean that you can capture a video 
format but not play it back in real time or else you can play back a video format but not capture it in real time.

The “Will it Work?” panel shows common video formats and instantly displays a check mark or cross to show 
if the disk performance will be adequate for the desired video format. We suggest you allow Disk Speed 
Test to perform several test cycles to help reveal any video formats for which the disk storage performance 
might be marginal. If you observe a check mark and a cross switching between each other for a video 
format, this would indicate that the disk storage cannot reliably support the video format.

The “How Fast?” results panel shows the frame rates your drive can achieve in frames per second and 
should be read in conjunction with the “Will it Work?” panel. If the “Will it Work?” panel shows a green 
check mark for 1080p@59.94fps in 10 Bit YUV 4:2:2, but the “How Fast?” panel shows that a maximum of 
60fps will be supported, the disk storage performance is too marginal to be reliable.

How Fast?
After each Read or Write test, the results will be displayed in the “How Fast?” panel. The “How Fast?” 
results panel also enables you to see how many streams of video can be supported by your disk storage. If 
the result for “HD 1080” is 70, you can run up to 70 frames of HD 1080 video per second. 

This storage speed is capable of supporting the following video formats:

 � 2 simultaneous streams of 1080i50 video at 25 fps per stream
 � 1 stream of 1080p50 video at 50 fps per stream
 � 1 stream of 1080p59.94 video at 59.94 fps per stream

Disk Speed Test interface during a test
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Getting Help
The fastest way to obtain help is to go to the Blackmagic Design online support pages and check the latest 
support material available for your HyperDeck.

Blackmagic Design Online Support Pages
The latest manual, software and support notes can be found at the Blackmagic Support Center at  
www.blackmagicdesign.com/support.

Contacting Blackmagic Design Support
If you can't find the help you need in our support material, please use the "Send request" button, on 
the support page for your HyperDeck model, to email a support request. Alternatively call your nearest 
Blackmagic Design support office at www.blackmagicdesign.com/company.

Checking the Software Version Currently Installed
To check which version of HyperDeck Utility software is installed on your computer, open the About 
Blackmagic HyperDeck Utility window.

•	 On Mac OS X, open Blackmagic HyperDeck Utility from the Applications folder. Select About Blackmagic 
HyperDeck Utility from the application menu to reveal the version number.

•	 On Windows 7, open Blackmagic HyperDeck Utility from your Start menu. Click on the Help menu and 
select About Blackmagic HyperDeck Utility to reveal the version number.

How to Get the Latest Software Updates
After checking the version of HyperDeck Utility software installed on your computer, please visit the 
Blackmagic Support Center at www.blackmagicdesign.com/support to check for the latest updates. While 
it is usually a good idea to run the latest updates, it is a wise practice to avoid updating any software if you 
are in the middle of an important project.

http://www.blackmagicdesign.com/support
http://www.blackmagicdesign.com/company
http://www.blackmagicdesign.com/support
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Caution: Risk of Electric Shock
On HyperDeck Studio Pro rear panel you will see a yellow warning label marked ‘Caution: Risk of Electric 
Shock’. This is intended to warn users that there may be the presence of uninsulated “dangerous” voltage 
within the HyperDeck Studio Pro’s enclosure which may be of sufficient magnitude to constitute a risk of 
electric shock to the user. Blackmagic Design do not recommend that you open the HyperDeck Studio Pro 
unit, but contact your nearest Blackmagic Design service center should assistance be required.

Achtung: Stromschlaggefahr
Auf der HyperDeck Studio Pro-Rückseite befindet sich ein gelbes Warnetikett mit der Aufschrift 'Caution: 
Risk of Electric Shock’. Dieses warnt den Benutzer vor einer möglichen, nicht isolierten, "gefährlichen" 
Spannung innerhalb des HyperDeck Studio Pro-Gehäuses, die einen Elektroschock verursachen kann. 
Blackmagic Design empfiehlt das Gehäuse des HyperDeck Studio Pro nicht selbst zu öffnen, sondern bei 
Hilfebedarf das nächstgelegene Blackmagic Design Servicecenter zu kontaktieren.

Attention: Risque de choc électrique
Sur le panneau arrière du HyperDeck Studio Pro, vous verrai une étiquette d’avertissement de couleur jaune 
sur laquelle est inscrit « Attention : Risque de choc électrique ». Cette mise en garde est destinée à avertir 
les utilisateurs de la présence possible d’une tension « dangereuse » non isolée à l’intérieur du boîtier du 
HyperDeck Studio Pro, laquelle tension pouvant avoir une magnitude suffisante pour constituer un risque 
de choc électrique à l’utilisateur. Blackmagic Design vous déconseille donc d’ouvrir l’unité HyperDeck 
Studio Pro, et vous recommande de contacter votre centre de service Blackmagic Design le plus proche en 
cas de nécessité.

Caution label on rear panel

Warnetikett auf der Rückseite

Avertissement sur le panneau arrière
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12 Month Limited Warranty
Blackmagic Design warrants that this product will be free from defects in materials and workmanship for 
a period of 12 months from the date of purchase. If a product proves to be defective during this warranty 
period, Blackmagic Design, at its option, either will repair the defective product without charge for parts and 
labor, or will provide a replacement in exchange for the defective product. 

In order to obtain service under this warranty, you the Customer, must notify Blackmagic Design of the 
defect before the expiration of the warranty period and make suitable arrangements for the performance 
of service. The Customer shall be responsible for packaging and shipping the defective product to a 
designated service center nominated by Blackmagic Design, with shipping charges pre paid. Customer 
shall be responsible for paying all shipping charges, insurance, duties, taxes, and any other charges for 
products returned to us for any reason. 

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or 
inadequate maintenance and care. Blackmagic Design shall not be obligated to furnish service under 
this warranty: a) to repair damage resulting from attempts by personnel other than Blackmagic Design 
representatives to install, repair or service the product, b) to repair damage resulting from improper use 
or connection to incompatible equipment, c) to repair any damage or malfunction caused by the use of 
non Blackmagic Design parts or supplies, or d) to service a product that has been modified or integrated 
with other products when the effect of such a modification or integration increases the time or difficulty 
of servicing the product. THIS WARRANTY IS GIVEN BY BLACKMAGIC DESIGN IN LIEU OF ANY 
OTHER WARRANTIES, EXPRESS OR IMPLIED. BLACKMAGIC DESIGN AND ITS VENDORS DISCLAIM 
ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
BLACKMAGIC DESIGN’S RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE 
WHOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR ANY INDIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER BLACKMAGIC DESIGN 
OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES. BLACKMAGIC 
DESIGN IS NOT LIABLE FOR ANY ILLEGAL USE OF EQUIPMENT BY CUSTOMER. BLACKMAGIC IS 
NOT LIABLE FOR ANY DAMAGES RESULTING FROM USE OF THIS PRODUCT. USER OPERATES THIS 
PRODUCT AT OWN RISK. 
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